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visually describes these items. SketchUp Make 2017 can be a helpful tool with regard to creating a site
logistics plan and can even provide a 3D model with regard to this. The following example will show
how this tool can be used.

All projects have “civil” site plans that are part of the construction/bid drawings and which show
boundary lines of the property, the location of the building, elevations, the location of important utilities
among other items. The following example will use a civil site plan called SitePlan.jpeg which is found on
your CD/FLASH DRIVE or the course site in order to create a site logistics plan/drawing.

Open SketchUp Make and select an architectural template. Select and delete the “person” leaving only
the three axes which intersect at the origin. Go to File and click on Import and choose the file named
SitePlan.jpeg from the Section 2 folder on the CD/FLASH DRIVE. This will bring the image into SketchUp
oriented into a plane. Click on the origin so that the image is anchored at this point. Go ahead and
stretch it so that it fills a decent part of the screen and use the orbit tool so that you are looking at it
“head on”.

Go ahead and place a building mass on the site as shown. Because the building is not oriented with the
standard axes we will begin by moving the axes to the corner of the building. Go to the Tools menu and
select Axes. Choose the corner of the building, then another corner to set one axis. The click another
point to set the second axes.

%
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Fourth — Draw a Line across the front

Second — Select Corner

Next we will have to scale the imported site plan to be somewhat accurate as we begin to develop the
site logistics plan. Remember the imported site plan is just an image file that is stretched. To do this we
will choose a dimension that is shown on the site plan (for this we will choose the front building length
which is 103 feet across the “front of the building”. Use the lines tool (i.e. the pencil) and draw a line.
Next select the Tape Measure tool and then hit the Ctrl key once (this will remove the little “+” sign from
the tool. Click on one end of the line and then click on the other end of the line. Type in 103’ (this should
be displayed in the Length window). Then press Enter and the following should occur.

rom. Cirl = toggle create guides. Enter value 1o resize model.

Length 103'

Click Yes. Because of the new scale your building may “disappear” but just go the Camera menu and
click Zoom Extents. Go ahead and use the rectangle tool (twice) to draw the building mass and use the
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Push/Pull tool to give it a 20 foot height. (If the axes get reset to the original just replace them as

before).

In this example we will place an access drive, laydown area, job trailer, dumpsters and temporary
parking lot. Go ahead and place the access drive in from Ludlow Avenue using the Line tool. Make sure
the Object that you draw to represent the drive is a closed form (Experiment with the Arcs tool for the
curve if you like). Use the Rectangle tool to draw the laydown area that is 75’ x 40’ and use the Paint
Bucket to select “Color” and choose a red. Under Tools select Text and Enter “Laydown Area”. Next
Place a 30" x 15’ rectangle as shown this will be the site for a construction trailer. Use the Orbit tool and

your plan should look similar to this:

Now go to the Window menu and choose 3D Warehouse and search for “construction trailer”. You will
have many choices. Choose “Download” and it will ask to load this into the model — say “yes”. Place it of
the pad you have drawn by clicking on the corner of the pad (experiment with the rotate and move tools
to orient it as desired). Finally search the 3D warehouse for dumpsters and place two of these on the
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opposite side of the building. Finally, use the Rectangle tool to draw a temporary parking that is 75’ x 50’
and use the Paint Bucket to select “Color” and choose a green. Under Tools select Text and Enter
“Parking”. It should look like this.

There are many other things you can do with the site logistics plan. Feel free to experiment — try out

other items from the 3D warehouse, use the camera tool to walk through the site, and many other
things.

%
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text. Simply do that by hovering over the cell boundary and clicking and dragging when the
expand symbol shows up. The quantity takeoff table should look like this:

Froperties Paremeters Lojumns Hows I1ties & Headers

Modify Schedule/Quantities
Project Browser - Revit-Takeoff.rdt X

<Wall Material Takeoff>

qa-Stair Quantities

ga-Window Guantities A | B | c

qc-Parking Quantities Haterial: Area Cost Family and Type

qe-Planting Quantities

qc-SiteCutFill 200 06 0.00 Basic Walk Generic - 8"

i =

qe-Electrical Equipment Quar 113 Sf 4.0 BES&_E Wak Gm@c 4
Electrical Fid Q s 193 SF 0.00 Basic Walk Genearic - 8”

I8 e ICUE e Hiors 0.00 Basic Wal Generic - &

qe-Lighting Fixture Quantitie
gm-Mechanical Equipment Q
gm-Specialty Equipment Qua |
- gp-Plumbing Fixture Quantiti |
gs-Floor Quantities by Assem |
as-Raof Quantities by Assem|
gs-Structural Beams & Bracin = |
gs-Structural Celumn Schedu
gs-Structural Framing Schedu
qs-Wall Quantities by Assemk
Room Arez by Department
Wall Material Takeoff La
ts (21)
0% - Temporary Schedule Sh
101 - Substructure
102 - Superstructure

Notice that the Wall Material Takeoff is highlighted in the Project Browser as the takeoff table
is shown in the display. If you would like to navigate back to any particular schedule or view of
the model you can do that through the Project Browser. Go back to the 3D view by clicking on
3D in the Project Browser.

ReBii-&«-- -2 SO AN G2 RS Revit-Takeoff - 3D View: (30} |7

Fite Architecture  Structure  Systems  Insert Annotate  Analyze  Massing & Site  Collaborate  View Manage Add-Ins

r:}l: :[E Visibility/ Graphics [f':' Show Hidden Lines +? Render b [} Pian Views
L

n = - . = i

View fﬁ_ Fiiters [:5 Remove Hidden Lines 0:; Render in Cloud 3D )

Templates =~ Thin Lines Render Gallery View
Select = Graghics 3 Presentation Create
Properties x )
M 3D View - [

3D View: (3D} ~| B Edit Type r
Graphics 2.

View Scale

S¢

78 =1-00 =

Detail Level Medium ]
Parts Visibility  Show Original |

Visibility/Grap.. | Edit. ] |
Graphic Displa... _ Edit. | ’
Discipline Architectural - §
Properties help I

Project Browser - Revit-Takeoft x !

— Elevations (Building |
= Architectural |
East
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Click the red icon and the Estimator panel will open. Open up the Estimator.skp file located on
the CD/FLASH DRIVE or course site. This file contains a simple Sketchup model of a model with
four walls (brick) and a metal roof. Open Estimator and choose the Material tab.

Using the Selection arrow, select a wall (notice the Material Selected box says “Brick Rough
Dark) and holding the Ctrl key select the other 3 walls. Under Description type in “Brick —
Walls” and in the attributes box select “Feet?” from the menu. Enter in “150” for the Unit Rate
and type in “SF” for the Unit Displayed.

[ o ——— : @ = ‘ o Estimatmr'; il ; : e
| € ESTIMATOR & | € ESTIMATOR : s
; [ Components T Layers T Materials T Quotes TRepnrts l [ Compoenents T Layers T Materials T Quofes I Reports '

< & » + o f -
10f1 L ; < 10F1 > + (]
(78180) : S0.00
{550) SF: 582.500.00

Material Selected:

|[Erick Reugh Dark] v IMatenal Selected: _!
[Brick Rough Dark] v

R} include in Estimate
E Include in Estimate

Cosi Code:
! Cost Code:
Descriplion: ;
|Brick - Walls Description:
Yendor: |Brick - Walls
I Vendor:
Attribute: {
lFeeF w |
Y = Aftribute:
Muitiplier rounc up o closest unit Fest? -
[
" Bluitiplier: round up io closest unit
Unit Rata: R T T
- 1*1
1159 L m
Unit Rata: Unit Displayed:
Labor [isa [6F
o !
i
Labor: Waste: (3] Tax: (%]
[
¥ ) 1]
Save Charges Claar | iE {

Ssve Chaenges Clasr

Before “Save Changes” is Clicked
Cost Extimats $0.0D
fnclude Quote include Margin[J %

AP T }0 € Cost Estimats $82,500.00

I Include Quotes || include Margin I}{} % €
;

After “Save Changes” is Clicked

Click “Save Changes”. Notice the Cost Estimate changes to $82, 500 based on a 550 SF of brick.

Repeat this by selecting both sides of the roof (remember to hold the Ctrl key down). Put in
“Roof” for the Description. For the attributes box select “Feet?” from the menu. Enter in “75”
for the Unit Rate and type in “SF” for the Unit Displayed. Click Save Changes. Did you get the
following?

e e e e B A e o A e o e B S
Section3 Page 84




Format Extension Version
Navisworks .nwd .nwf .nwc All
AutoCAD dwg .dxf Up to AutoCAD 2014
MicroStation .dgn .prp .prw V7, v8
3D Studio 3ds .prj Up to Autodesk 3ds Max 8 2014
ACIS SAT .sat .sab All ASM SAT. Up to ACIS SAT v7
Catia .model .session .exp .div3 V4, v5
Cis/2 .stp STRUCTURAL_FRAME_SCHEMA
DWF/DWFx dwf .dwfx All previous
FBX fbx FBX SDK 2011 3.1
IEC e IFC2X_PLATFORM, IFC2X_FINAL,
IFC2X2_FINAL, IFC2X3
IGES .igs .iges All versions

Navisworks Manage® utilizes three “native” file formats — nwd, nwc and nwf. It is important that the

construction manager know the difference between these three file types.

Navisworks File
Types

Description

NWD

An NWD file serves as a published record of the model containing
all model geometry together with other Navisworks data. You can
think of an NWD file as a snapshot of the current state of the
model. Compared to CAD files this file type is small which makes
it ideal for transmitting — it is recommended always to send this
file type for your assignments.

NWC

NWC files (“cache files”) are smaller than the original CAD files,
and speed up your access. Anytime that work is performed using
Navisworks Manage® a NWC file is produced. When you next
open file or append file in Navisworks, the data is updated thus
creating a new cache.

NWF

An NWF file contains links to the original native files (as seen on
the Selection Tree) together with other data. It is basically a
master file that links together all the original files that are used to
create a consolidated model but it does not contain model
geometry. Therefore these are files that should not be transmitted
for assignments.

It should be noted that Revit® files can be directly opened in Navisworks Manage® but it can be a slow

process depending on the complexity of the Revit® file. Exporting the Revit® file as a NWC file type,

although not absolutely necessary, may improve the performance of the software depending on your

computer and server. The process for exporting a rvt file from Revit® into Naviswork Manage is shown

below:

In Revit®;
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4.4 Working with Files in Navisworks Manage® - Checking for Clashes

One of the primary tools found in Navisworks Manage® is the Clash Detective tool which allows the user
to find where two objects intersect or clash. This tool is very important to the construction ma nager as it
allows for clashes between systems (and sometimes within a system) to be found during various stages
of design development. The file you will be working with is the Section4-Consolidate.nwd file you
created earlier.

To check for clashes you begin by opening up the Clash Detective window by

1. Clicking on the Clash Detective button which is found on the ribbon under the Home tab. This is
shown below:

View Ouiput Render o -

D’_ éz‘; @ [-@1’ % L!;[’l‘s E L‘;‘hF\r:d \-temz d:":“

P E [
xS y & =
Append Refresh Recet File Select Select _Selection ~ ) Unhide  Links Quick Properties
* Al Options | T Al Tree [Elses ~ & Al Properties
Project ~ Select & Search ~ Visibility Display

The Clash Detective window has two parts. The top part of the Clash Detective interface shows the
name of the current test. In this case it says "There are no clash tests currently defined" because we are
just getting started.

| Clash Detective o I
' e |
There are currenily no clash tests defined. J & AddTest | 53 | {

The bottom pane of the interface has four tabs — Rules, Select, Results, and Report. Currently the Select
tab has been chosen. The Select tab allows you select the items that you wish to run by choosing an
item out of Selection A and an item out of Selection B. Notice currently the Section4-Consolidate.nwd
file looks something like this:
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x E

| 1items selected | Quick Property Definitions... | | Save Selection | | &~
{ 1 |
em Item
MName Type

!3, !_E; % W-Wide Flange Structural Framing: W-Wide Flange: \@-12%\

4.5 Working with Files in Navisworks Manage® — Clash Results

In the previous section we were introduced to the Results tab in the Clash Detective. You can toggle
between the Select tab and the Results tab very easily. Looking at the Results tab for the L2-Framing-L1-
Duct Clash test the bottom section of the Results interface will list the 3 clashes as we have already
seen. Notice that each object in a particular clash is given a specific color. In this case the structural
framing objects involved in clashes have a red color and the duct objects involved in clashes have a
green color.

On the right side of the interface box you can click on the Display Settings if it is not already shown. It
should look like this:

R e o e e e S A e e I S T e e e
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Notice Dim Other
(Transparent Dimming)
Shows a Wire Frame of
the Model

If you would like to identify an element in a clash you can click on it in the display area. It should be
highlighted. You can then right click on it and choose “Selection Inspector”. That will make a box visible

that has more information about the element involved in the clash.

Here we can see the memberis a W 12 x 26. Another way to do this is to select the “properties” button

on the ribbon located to the left of the Clash Detective button.
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6. Click Run Test. This will initiate a test that looks for intersections between the subsets of Level 2
structural framing and Level 1 HVAC ductwork.

This test will come back with 3 hard clashes as shown in the top part of the Clash Detective interface as
shown below. A hard clash is defined as an intersection of the geometry of the components being
checked or an actual interference. You can get into the area of soft clashes where the space to work on

a component or mechanical device is not large enough to allow for maintenance but that is a topic for
more advanced coverage.

Notice that all clashes are considered a new clashes because presumably this is the first time we have
run through this model looking at first floor structural framing and lower level duct. The other status

boxes for clashes (i.e. active, reviewed, approved, resolved) will be discussed more in the next section.

In the viewing area you can see the two items in Clash 1 that have been flagged. It might be worthwhile
to investigate the “Dim Other” and “Hide Other” buttons at this point. Notice how the “Hide Other”
blacks out everything except the clash while “Dim Other” shows a faint representation of the adjacent
elements (either wire framed or as a grayed object depending if Transparent Dimming is chosen).

|| Clnen Detective = & @ﬁj} =, F‘ |g | (A_;: ) 1 N
- — o 3 ) —’ 1 =
| . : Unhide  Links Quick Properties | Clash | Timeliner Quantification  Autod

12-Framing-11-Duct Last Run: Wednesday, May 06, 2015 1:27:14 PM. | Al Progetes | Dietectivel Rende

Clashes - Total: 3 (Open: 3 Qosed: 0) oo Displa

Name Status Qashes [ Hew Active IReviewsd [Approved  Resohed
L2-Framing-l1-Duct Done 3 3 o a 0 o

3 New Clashes Found

| B AddTest | | Reset2l | CompactAll | Deletedl | A8

i Rules | Select | Results | Report

| | { Grew Group L’L}i | 8, Assign | iﬂ_‘ iNene ~ | |5 | | Rerun Test

e e
GridInt... Fou.. Approved.. Highlighting

| tem1 & | ltem2

Use item colors. bt

Level

@ Clash2
@ Clash3

V. Highiight all dashes

T sBupes Aeydsig

Isolation ————
| Dim Other | Hide Other | | |

Auto reveal . | |

Viewpoint
| Auto-update
Animate transitians

Focus on Clash

|  -simulatien ==
| | ' Show simulation
I

Notice also that each clash can be viewed individually by simply clicking on their respective name
(Clash1, Clash 2, Clash 3). To gain perspective you can click on the display area and spin the wheel of
your mouse to zoom out (you can push the wheel of your mouse to “pan” the display) on the 3 clashes
found if the “Highlight all clashes” is checked on.

T e e T e e e e e e e e e R P S LT RS
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In this example a clash test will be performed between the first Floor Structural Framing and the Lower
Level Ducts in the MEP model.

4. Go to the top pane and click where it says Test 1 and type in "L2-Framing-L1-Duct". This will be
the new name for this test which will be a comparison of a portion of the Level 2 structural
framing against the Level 1 HVAC ductwork.

5. Go to the bottom pane in the selection A column open up the Section4BaseStructural menu by
clicking on the "+". Go down to the line that says "Level 2" and again expand the menu and click
on Structural Framing. On the selection B side open up Section4BaseMEP menu by clicking on

the "+". Go down to the line that says "Level 1" and again expand the menu and click on Ducts.
1 Clash Detective x
| & Testl Last Run: <Mone>
Clashes - Total 0 [Open: 0 Closed: 0} .
g ; e [ | S S — s S N N
Mame Status Clashes [ New Active Ireviewed [ Approved Resolved
i
L2-Framing-L1-Duct L] a a 2] 0 a
b
o e e e, K e s S 1
fi |« ] »| 1
Mt e e T A R e e R T S e e T e A R e L
| i f5 Add Test ] | ResetAll | CompactAll | DeleteAll | | (2 Update All | & - | |
R i S i
Rules Select | Results | Report i
| -Selection A - Selection B 4
it | H
ko Y {
i | Standard | l Standard - i
| | [ B[5]Sectiond-Consolidate.nwd Bg] 5ectiond-Consolidate.nwd i
E Q SectiondBaseStructural.nwec E| SectiondBaseStructural.nwe
I B Level 1 B Level 1 i
i % M2 Structural Columns B Level 2 |
Il | BE Level 2 E £ T.0. Footing
{ ; @2 structural Columns | @£ Roof
il + ldstructural Framing, , B[g)] Section4BaseMEP.nwc
i @£ T.0. Footing BE Levell
H @£ Roof 22 Air Terminals
§ Section4BaseMEP.mwc 232 Duct Fittings
H¥dDucts)
HE Level 2
| 1
FILER AT | (el (o3 lem |1
B ] b | | |
i |
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WX

P
£
|
Last Run: Saturday, December 13, 2014 10:38:19 AM |
Clashes - Total: 1 {Open: 1 Closed: 0] |

Selection Inspecior

1 items selecied i Quick Property Definitions... 1l Save Selection i %' | '
Itam Item
Hame Type

|®| %] & W-Wide Flange Structural Framing: W-Wide Flange: W10

,Assign | El Sone ~ ‘ 5 5 I'”' Re-run Test |

Level Grid Int... Fou.. an'm nghhghhng

| ‘Use ilem calars i '-
| & nghllgh{ al\ (Iaih:s

;Iﬁ [T n(.ﬂ |}1 5ia

| lsolation ——
| pr—— |
| || Dim Other HrdeDtherI

i
[ 1¢ ﬁuto reveal

Viewpoint —
| Auto-update -
Animate transitions.

| {‘77 Focus on Clash |
We also mentioned how useful it is to gain information on a member involved in a clash is the Properties
button located next to the Clash Detective button. Once clicked, this will open up a panel that contains

many attnbutes for the selected item.

S F G- Sutedesk T s Merage 2014 (EDUCATIONAL VERSION] Sectiond-Consolidatened R -
e VEw  Gutpi . Render

=)

AR = (G Findhems
Ci = . 5
Select _ Selection =~ 2 Unhide 1§ repertiell € r Qus n  Autodesk  Animater
& Yice r_,]sm -8B &l orilics ctiv Rerdering
PR | & et L5 T R T O S T T VIR s
Clash betectve .
12-Framing-L1-Duct Last Run: Wednesday, May 06, 2015 1:27:14 P
Clashes - Totak: L (Open: 1 Closed: 0]
Hame status  Clashes  [hew active  [Redewed | Approved  Resobed
\2-Framing41Dudt Done 1 1 ] ] o ]
|3 AddTest ResgtAll | Compactdll | Delete dll | B 1
Fules Sl Results  Report
|19 rew rowp | Sone = || | || RerunTest|
Nam LT status Leve GridIne.. Found Appeoved.. Apoet  Highlighting
WiNewGroup [ New “ T Foan CFTH1f.. 132714 06-05-2015 [(mem1 & mem2 ™

|7
‘ Use ltem colors -
| 7 Highlight all dashes

| ksolation
| | Dim Other | Hide Gther

‘ 7 Transparent dimming
o Auto reveal

Knowing what items are actually clashing is very important as you move towards resolving that issue. A
coordination meeting will have to be held on this part of the building between the construction
manager, the MEP contractor and probably the structural engineer and/or architect to discuss the best
way to resolve any clashes. In many cases, the structure of the building will be considered fixed as
moving structural elements will be more difficult if the design has progressed beyond the schematic
phase. Therefore, the clashes that are occurring between the structural framing and HVAC ductwork will
likely be remedied by moving the ductwork. Among the various subcontractors, the HVAC system is
probably the system that is hardest to relocate because of its size and scope. For instance, it is easier to
re-locate sprinkler system (i.e. fire protection) components around HVAC ductwork than it is to move
the ductwork to accommodate the sprinkler system. Although the hierarchy of systems can change
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4.9 Navisworks Manage® — Reports in the Clash Detective

The last tab in the Clash Detective pane is called Results and this allows the user to configure how the
clash information can be reported to other individuals. This might be a helpful method of formatting and
consolidating clash information if the parties involved either cannot attend a coordination meeting or
for keeping records of each stage. The information that is desired in the report can be clicked on or off
and the type of report format selected. Please be aware the “Write Report” button is analogous to the
familiar “Save As” button.

If we were to run the original clash test on the Section4-Consolidate.nwd model (finding 3 clashes
between the Level 2 Structural Framing and the Level 1 Duct) and clicked on the report tab we could
change the Report Format to “HTML (Tabular)”.

ChshDelertite i

Rules | Select | Results Report

Contents e o

Tratkite Elahumeme e Mo Lo D
JiSummary : s For Clash Groups, indude:

JiClash Point
1Date Found

¥ Assigned To = Include only filtered results
' Date Approved
< Approved 3y | Indude “i,sf f,(itfs,e,s: -
¥ Layer Name | [ New
_Item Path v Active
< Ttem ID || ¥ Reviewed
¥ Status v Approved
¥ Distance - + Resolved

- Qutput Seitings - _—

Report Type Report Format

[Cumenttest i + | |HTML (Tabular) - | Write Report

1. Click on “Write Report”. It will prompt you to the “Save As” where you can select a name (or use
the default) and a location for the file. Click Save.

2. Go to that location. You should see a folder which has the clash images in it and an HTML file
icon with the name associated with the report (I saved it as “Test 1”).

Test 1

3. Click on that icon and the report should look like this:

Test 132!_91_3!_1_ ce ,(_:_Ia_sbe_s New Active Rgviewed‘APpr?yed Resolved‘—TvpeiStams

0.003ft 3 3 a 0 0 1] Hard] OK

Item 1 Item 2

clach Status Distance e 5 Description Date Found  Clash Point Item ID Layer ltem Mame Ateey Item ID Layer ltem Name

Mame Location ! ; Type

! B-1:T.0. 2018/1/14 x:15.770, y:10.383, Element ID:  level Steel ASTM 2 Flement 1D:  Level Rectangular
Chsht  sNow! LOS16: g tacs 1954 2:16.122 128663 2 A%z Solid  gapa3 1 Duat

g C1:7.0. 2018/1/14 x:23.270,y-10.383, Efement ID:  Level Steel ASTM 5 Element ID:  Level Reciangular
dlash2i S News FOTe L hiee 15:54 216137 130393 2 A992 Solid 30202 1 Duat

. I A1:TO. 2018/1/14  x7.730,y:10.383, Element iD:  level Steel ASTM _ . ElementID:  Level Rectangular
e A0 e Hard 15:54 216.153 130520 7 A992 Sold £30204 1 Duct
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Timeliner

| Tasks Data Sources | Configure | Simulate

| FEgladd l

' MName Start Appeara End Appearance |
Construct Green [909% Transparent) Model Appearance

| Demalish Red (90% Transparent) Hide

| Temporary Yellow (90% Transparent) Hide

5.3 Navisworks Manage® — Creating Timeliner Using a Linked Schedule

A second way to “timeline” a model in Navisworks is to link an actual construction schedule
with it. Based on the previous model (with Footings, Columns, and Beams), a simple MS project
schedule can be created. If you do not have experience with the MS Project scheduling
software a simple schedule has been created for you and it is named
TimelinerSchedExample.mpp. This file is found in the student CD/FLASH DRIVE or on the
course site. This MS Project schedule has the same 3 activities (tasks) found in the
TimelinerSampleModel.nwc file — footings, columns and beams. For this exercise each of these
activities (tasks) will have durations as follows; foundation = 10 days, columns = 2 days, beams
= 3 days. Each activity (task) will have its logical predecessor (i.e. footings precede column). The
simple MS project schedule might look like this if you opened it in MS Project:

5, Micrasoft Preject

e B Vidw ket oot Toch Broid

ollaberaie  Window  H
2 &8 | &= @ MNoGroup =R AF BEEIe > - Show~ | Anal -8 - B I

1€
(=}
]

i W Y b5 S
I Tesks - Resources ~ Track - Repot - -

*=] TimehnerSchedExample-5.mpp

@ Taskdame Turaton Start Fnoh  Predeccssors  Resourceames 3018 (Warao Apr 20,14
TIWT I

pr20, - ==l S
ST WITIF[S 5M[T W T|F

LA | Foundatans 10 days Friame  Thu 817114

. - Bears Jdays  Tus42ME  Thusz4ds 3 Fﬂ;ﬂ
g =

Coturms 2days  FA4ABAG  Mon 224 1

—

If you do not have access to MS project the file already exists in the Section 5 folder. The file
name for the MS Project file is TimelinerSchedExample.mpp. Do the following:
1. Close (without saving) Navisworks Manage
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5.6 Navisworks Manage® — Identifying Time-Based Clashes Using Timeliner

It is easy to forget that clashes occur not only between objects that are constructed to “stay-in-
place” but that clashes can occur between temporary elements that are needed to actually
perform construction in the first place. There are items such as scaffolding, formwork, and
equipment that are temporary elements that may have to be removed for other elements of
construction to take place.

Although the tower crane does not remain in place forever, a construction manager would have
to consider its location, height and swing radius relative to the construction of the building
frame. Although it seems obvious, a temporary item (like a tower crane) should not interfere
with the construction process by clashing with building components. Construction managers
and contractors must be able to anticipate conflicts and interferences that could arise through
the placement and scheduling of temporary items. The Timeliner tool can be used in
conjunction with the Clash Detective tool so that temporary items, such as equipment, can be
compared to the building model to check for time-based or “soft” clashes. Identification of a
time-based clash will alert the construction manager to the need of adjusting the location or
scheduling of the temporary item.

The following example will demonstrate how the Timeliner and Clash Detective tools can be
used together to help a construction manager coordinate the timing of activities on a project.
Using Navisworks Manage®, the first step is to open the Section 5 folder on the Course site or
on the student CD/FLASH DRIVE and find a file named TimeBasedClashModel2.nwc. You should
see the following on your display area in Navisworks.

e i e S
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Once the Sets for the model have been completed, use the Append button and append a file
named TimeBasedClashMass.nwc. The cylindrical mass is representing the zone of operation

for a crane. Once this is appended the display should look as follows (you may have to click the

“Home” icon above the View Cube.

Select the cylinder mass and add it to the Sets, you can call it Equipment. Now your Sets pane

should look as follows:

e

Selection Tree

Sefs

Standard

1 TimeBasedClashHudeIanE N

TimeBasedClashMass nwe
]
} B2 <o level>
| B8 Mass
“eHMass1
B2 Mass 1

¥ ass 1

Bohes 20 4l
| ~-~-.i'lFootingsRow1
(i) FootingsRow2
*"-ZEI FootingsRow3
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Open the Clash Detective, and click the Add Test (you can leave it titled Test 1). Run a clash test
comparing the model to the mass. The selection panes would look as follows:

Rules | Select | Results | Report

Selection A ———— -Selection B -

Standard v | Stendad v

‘ TimeBasedClashModel2.nwc

{ |
i |

When
looking at the Results, you should notice that there is a clash detected.
Rules : Select | Resulis  Report

|[ Y Mew Group | |+ | i&iAssign i |Q| ‘ FiNone | |5 ‘#_ | |#2 Re-run Test\

T T e e i i 1 3
Nan r‘\lr‘z;:::qa;.f empty clash group. i Leve Grid Int.. Found Approved... - Highlighting —————— I
‘ | Eem1 Item 2 | ilrs
} iUse itern colars '_" § %,

[CBElEmIeRE . w
| [¥] Highlight all clash | §
e 4 =

risolation —————

: L=l
1 | Dim Other | Hide Other |
‘ |

mming |

The mass is interfering with the slab (which seems fairly obvious). You can see from the

Selection Tree that the slab interfering with the mass is second element listed (which is Slab
Pour 2).

Selection Tree

| Standard

B|s| TimeBasedClashModel2.nwc
BE Level 1
BE Level 2
87 Floors
B2 Floor
B2 Concrete Slab - 6

B & Floor
=L Floor

TimeBasedClashMass.nwc
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Timekiner

Tasks | Data Sources | Configure | Simulate Columns Show/Hide Gantt chart
Rl &, ‘ [ = -l- ‘ .
| ‘DATEach l o' J | , | | ; Zoom:
Active Name Status  Planned Start  PlannedEnd  Actual Start | ActualEnd  Task Type Attached Total Cost
™ Foundatons = 1/17/2018  1/25/2018  M/A N/A Comstruct @ Sets->Foundations
¥ Columns = /2942018 1/31/2018 N/A N/& Construct @ Sets->Columns
v A Raame =3 2012018 2/2/2018 N/ NiA Corstruct @ Sets->Beams

You can treat the Total Cost Column as if you were a Cost from a Schedule of Values. It is
usually considered to be in some manner made up of Labor, Material, Equipment and/or
Subcontractor Cost. Go ahead and Show the Material, Labor and Equipment Cost Columns.

2. Click on the Columns button and click on “Choose Columns. Then “check-on” Labor,
Material and Equipment Cost. Then click “OK”. You should now see the following:

| Tasks | Data Sources | Configure | Simulate

== = [ro. =2 =l ige-) [FEl~ g y
| wpAdd Task | 5= | L~ | | i Attach~ | §g | o= \[E \_131 | Zee
Active Name Status  Planned Start | Planned End  Actua Start  ActudEnd  Task Type Attached Total Cost Material Cost | Labor Cost = Equipment Cost
7 Columns = 1/29/2018 1/30/2018  NA N/ Construct @ Sets—>Colurmns )

v Beams = 1/31/2018  2/2/2018 N/A N Construct @ Sets->Beams

3. Enter the following material, labor and equipment costs values for each task (the total
cost will add these automatically). Notice that the Total Cost is just a sum of the various
components.

Attached Total Cost  Material Cost | Labor Cost - Equipment Cost
@ Sets->Foundations 40,000.00 20,000.00 1500000 500000

| | Sets->Coumns 13500000 [12,000.00  {1500000 (800000
@ Sets->Beams 25,000.00 10,000.00 10,000.00  5,000.00

4. Toggle the Show/Hide Gantt button again

So far, when you ran the Timeliner simulation, you may have noticed that the simulation had
some time and date information scrolling across the screen. That is part of the “Settings”
button that is under the “Simulate” tab.
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Once you open up the report you should see the following:

ToleranceiClashes New Active Reviewed Approved Resolved Type Status

|Tes‘t1 0.00ft 1 TEERE 0 Hard OK

em 1 Itom 2 Task
Clash Grid N Item tem Iten;
Im.I==  MName Status Distance ici Dascription Date Found Clash Point KemID tayer item Name i ftem 1D Layer Narie Typd Name Start End

. 34:Level 2015/4/7 x76.32,y:45.33, ElementiD:  Level Concrate, Castin- . ElementiD: <Ne  Defaull __ N 015/4/17  2015/4/17
-Cl”"1 il Lot 15:26.25 21000 130725 2 Placegray Selid 430532 level>  Form Soliff  Equipment 5550 17:0.0

Notice the report lists items such as clash location and items but what is of primary interest is ¥,

the last part of the report which shown that the Equipment task was involved in the clash

starting on a date and ending on a day (the actual dates are not important to us in this
example). You can obviously see from the image and the other information that the clash is
with the equipment mass. It occurs as the equipment is “installed and ends when the
equipment is removed. To remedy this, the equipment (i.e. the mass) can be relocated, re-
scheduled or perhaps the sequence of constructed elements could be changed. What would
happen if the dates for SlabPourl and SlabPour2 were switched?

5.7 5D BIM Using Timeliner

The world of three-dimensional models can be linked with the time and logic of various tasks as
we have already seen with the Timeliner tool in Navisworks Manage to provide what many
people call 4D BIM. The Timeliner tool can extend this into another dimension — cost —as an
example of what many refer to as 5D BIM.

Cost can be assigned to a task in the Timeliner tool by manually entering a cost in the task pane
of the tool. The most basic cost to track is “Total Cost” but you can also input other costs such
as material, labor, equipment, and subcontractor. Costs could also be imported from a
scheduling software but that is beyond the scope of this introduction.

Go to the course site or CD/Flash Drive and open the file named TimelinerSDSample.nwd. This
is a simple building frame with three tasks — Foundations, Beams, and Columns which have
model elements grouped into Sets and those Sets attached to the Timeliner so the a Simulation
will run. Go ahead play the Simulation.

Now we are going to add cost values to the model.

1. Go to the Timeliner pane and click the Show/Hide Gantt Chart button. This reveals The
Total Cost column just in case you didn’t see it.

o e e . = - ..
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Overlay Text X

[ %A %X %x Day=$DAY Week=SWEEK
| $COLOR_RED|Total Cost=$TOTAL_COST
$COLOR_GREENCurment Activity=$TASKS

Date/Time Cost Exiras

Colors Font Tahoma :11

Cancel Help

9. Click “OK” in the settings tab. Your Timeliner should look like this:

L THE UpuUIS > ] B OHIBLLIUL HEE  [Lgaets v ol iy U A =i Frupsues

Proj Search ¥ Visibility Display

nt vity
tions [Construct 0%

Go ahead and run the simulation. The cost and schedule are being integrated with the
model which is the definition of 5D BIM. This can give the viewer a combination of

information that allows them to better visualize the progress and resources needed at
various stages of the project.
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